
    
Guide to Wizards & Demo Files

Panorama includes a number of pre-built databases that you can use as is, modify for your own purposes, or
simply use as learning tools. With only a few exceptions these pre-built databases are completely accessible
so that you can not only use them as is but also take them apart and see how they work. All of these data-
bases can be opened with the Wizards menu and its submenus.
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Wizard & Demo File Quick Reference

The wizards and demo files provided with Panorama fall into several categories.

Submenu Wizard Page Description

Main Menu

Live Clairvoyance Page 4 Performs “live” searches on any database

Database Information Page 5 View and modify database metadata information

Favorite Databases Page 5 Helps to keep track of your frequently used databases

New Database Wizard Page 6 Helps to design and create new databases

Search All Fields Page 6 Search entire database (not one field at a time)

View Wizard Page 8 Open form and procedure windows

Calculations

Formula Wizard Page 9 Workbench for experimenting with formulas

Mini Calculator Page 9 Basic math calculator

RPN Programmers Calculator Page 10 Calculator for decimal, hex, octal and binary

Run Automatic Calculations Page 11 Recalculate based on design sheet formulas

Developer
Tools

ASCII Chart Page 12 Table of ASCII characters

Channel Workshop Page 12 Assists with building new channel modules

Cross Reference Page 13 Organize multi-database projects

Custom Functions (ProVUE) Page 14 View custom functions included with Panorama

Custom Functions (User) Page 14 Create your own custom functions

Custom Statements Page 15 Create your own custom statements

Debug Log Page 15 Trace internal operation of a program

Dialog Workshop Page 16 Helps to build custom dialogs

Dropalyzer Page 17 Tool for analyzing drag and drop operations

Elastic Picture Workshop Page 18 Modify pictures so they won’t distort when stretched.

Resource Menu Editor Page 19 Edit custom menu resource files

Variables Page 19 Display and edit the contents of variables

Documentation

Panorama Handbook Page 72 Opens Panorma Handbook PDF Document

Panorama Movies Page 21 Watch Panorama Training Movies

Programmers Reference Page 24 Searchable reference to all statements and functions

Form Tools

Font Usage Page 25 Display list of fonts used in forms.

Form Explorer Page 25 Display/edit information about form objects

Icons & Backgrounds Page 26 Display images contained in Panorama itself

Window Size Page 26 Display size of window

Window Tweak Page 26 Disable window tool palettes and scroll bars

Internet

Address Info Page 27 Check address and zip code information

Bulk Email Page 30 Send mass e-mails

FedEx Tracking Page 32 Track FedEx shipment information

URL Wizard Page 33 Open web/email URL’s stored in current record

White Pages Page 35 Look up phone numbers
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Mini
Applications

Mini Calendar Page 46 Basic calendar/event database

Mini Contacts Page 42 Basic name & address database

Mini Correspondence Page 48 Basic correspondence/mail merge database

Mini Statistics Page 49 Calculate mean, standard deviation, plot distribution.

Stopwatch Page 49 Simple timer

Task Timer Page 50 Keep track of time spent on different tasks

Preferences

Channels Page 54 Configure channels for phone dialing, email, etc.

Generic Fields Page 58 Configure generic fields for contact information

Hotkey Manager Page 58 Configure universal and database specific hot keys

Speech Wizard Page 62 Configure speech templates

Utilities

Arrange Windows Page 70 Tile and stack windows

Disk Permissions Page 71 Display disk permissions (OS X)

Open Database Page 71 Open database with special options

Platform Converter Page 72 Convert between versions and platforms

Summaries & Outline Page 73 Categorize and subtotal database information

Text Export Page 73 Export data into text files

Text Import Page 74 Import data from text files

VCard Wizard Page 75 Import/Export VCard information

Submenu Wizard Page Description
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Primary Wizards

The most basic and commonly used wizards have been placed in the primary Wizard menu instead of in a
submenu.

Live Clairvoyance™

The Live Clairvoyance™ wizard allows you to perform “live” searches on any Panorama database. The
search results are updated dynamically as you type, allowing you to “hone in” on just the information you
are looking for. The search may include multiple fields or even all fields in the database being searched. (If
you've used the search box in iTunes you'll find the operation of this wizard familiar.) Using the Live Clair-
voyance wizard doesn't require you to do any programming or make any modifications to your existing
databases. Here’s what this wizard looks like in action.

To learn more about this wizard see “The Live Clairvoyance™ Wizard” on page 507.

as you type here

the matching records
appear here

clear search

change configuration

list of fields being 
searched

double click any line to 
find corresponding record 
in database window
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Database Information

The Database Information wizard allows you to view and modify descriptive information about any data-
base: the title, author name, description, keywords, etc.

To learn more about this wizard see “Viewing and Modifying Database Metadata” on page 263.

Favorite Databases

The Favorite Databases wizard keeps your favorite databases organized and at your fingertips. You can
quickly display, search for, and open databases you have designated as favorites.

To learn more about this wizard see “The Favorite Databases Wizard” on page 237.

double click to
open database
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New Database Wizard

The New Database Wizard makes it easy to design and set up the fields for a new database. You simply enter
the names of the fields you want to create and press the Make New Database button. The wizard does the
rest.

To learn more about creating databases with this wizard see “Using the New Database Wizard” on page 250.

Search All Fields Wizard

The Search All Fields wizard makes it easy to search all of the fields in a database at once instead of one field
at a time. Simply enter the word or phrase you want to locate and press either the Find or Select button.
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The wizard will locate the word or phrase no matter what field it is located in. If you use the Find button you
can jump through the database with the Next button to locate every occurrence of the word or phrase (in this
case Green).

For more information on this wizard see “The Search All Fields Wizard” on page 512.
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View Wizard

The View menu works well for most databases, but when a database grows to dozens of forms and hundreds
of procedures it can get a bit unwieldy. For these situations the View Wizard comes in handy. This wizard can
help you locate and open any view within any open database. The wizard displays a list of the views in any

database, including  forms,  procedures,  crosstabs, the   data sheet and the  design sheet.
The list is searchable, and you can even search all of the procedure source code to search for a field, variable,
or other program element. You can easily open any view by double clicking on it.

To learn more about this wizard see “The View Wizard” on page 355.

procedures

forms
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Calculation Wizards

The wizards in this submenu perform various types of calculations.

Formula Wizard

The Formula Wizard can be used as a workbench for working with formulas. You can experiment with for-
mulas here before you actually use them in your database. The formula wizard can handle formulas that use
numeric, text and date calculations (the illustration below shows a text calculation).

To get the complete scoop on this very useful wizard see “Using the Formula Wizard” on page 1303.

Mini Calculator Wizard

The Mini Calculator wizard performs basic math calculations. You can enter calculations with either the but-
tons on the form or with keyboard (or both).

As you press each button or key the calculator immediately shows the new result.
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You can click on the formula to edit it.

The wizard recalculates the newly edited formula immediately. In this case the new answer is 54.

You can use the Format menu to choose the format used to display the calculation result.

The 4 Digits format displays four digits after the decimal point.

You can type in any numeric function supported by Panorama. This example calculates the square root of 54.

To learn more about the numeric functions supported by Panorama see “Arithmetic Formulas” on page 1333.

RPN Programmers Calculator

The RPN Programmer’s Calculator can be used to perform numeric calculations and to convert numbers
between decimal, hexadecimal, octal and binary.

See “The RPN Programmer’s Calculator” on page 1427 to learn more about this wizard.
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Run Automatic Calculations Wizard

When you set up an automatic calculation that calculation is automatically applied when new data is entered
or existing data is modified. The calculation is not applied to any existing data. One way to apply a calcula-
tion to existing data is to use the Formula Fill command in the Math menu (see “Filling a Field with a For-
mula” on page 581). Another method is to use the Run Automatic Calculations wizard. This wizard will
perform calculations based on the formulas you have entered into the design sheet (see “Automatic Calcula-
tions” on page 468). You can recalculate all fields with formulas, or just the current field.

To learn more about this wizard see “The Run Automatic Calculations Wizard” on page 480.
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Developer Tool Wizards

The wizards in this submenu are designed to help design, build and debug complex applications with Pan-
orama.

ASCII Chart

The ASCII Chart wizard allows you to displays a matrix showing all 256 ASCII characters. When you click
on a character it types that character into the box at the bottom.

To learn more about this wizard see “The ASCII Chart Wizard” on page 1360.

Channel Workshop

Panorama comes with a number of channel modules for sending e-mail, dialing the phone, and interfacing
with other web sites and third party software. If you have programming experience you can write your own
channel modules. To help make this easier we have created a Channel Workshop wizard that will create the
core of your new module for you.

To learn more about this wizard see “Writing Your Own Channel Modules” on page 1977.
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Cross Reference

A complex real world system (accounting, reservations, order entry, etc.) created with Panorama may involve
a dozen files with hundreds of fields, variables, procedures, forms, etc. Keeping track of all this information
in your head can be a monumental task.

Panorama’s Cross Reference database feature can help make this task manageable. A cross reference data-
base keeps track of all the items in one or more databases: every field, every variable, every procedure, every
form—every everything. Not only does the cross reference database keep track of where these items are
defined, but also everywhere they are used. For example, suppose your database has a field named Title. A
cross reference database can tell you that this field is used in the Entry, List, and Label forms, and is also used
in the procedures .NewRecord and Search. Or you could use a cross reference database to find out that the
.LastYear procedure is triggered by buttons in the Entry and Annual Report forms. As your database applica-
tions become more complicated you’ll find that a cross reference database is an invaluable tool to help you
sift through a mountain of databases and programming.

To learn more about this wizard see “Cross Referencing” on page 1580.
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Custom Functions (ProVUE)

Panorama includes a number of custom functions that have already been defined for you. To see a list of
these functions open the Custom Functions (ProVUE) wizard.

You can also find these functions in the Programming Reference Wizard. For more information on Custom
Functions see “Custom Functions” on page 1461.

Custom Functions (User)

Panorama doesn’t limit you to the built-in functions that are supplied with a Panorama. In fact using the Cus-
tom Functions (User) wizard you can actually create your own functions that can be used in any formula.

For more information on Custom Function see “Custom Functions” on page 1461.
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Custom Statements

This wizard allows you to extend Panorama’s programming language by writing your own custom state-
ments. You can also examine (and even modify) the hundreds of custom statements that come with Pan-
orama.

For more information on Custom Statements see “Custom Statements” on page 1536.

Debug Log

The procedure debug log was originally developed as an “in house” tool to help debug Panorama itself. It
has proved so useful that we have decided to document and make it available for general use. When the
debug log is in use Panorama records procedure activity in a text file. Later you can review the text file to
trace the actions of your procedure.

To learn more about tracking procedures with this wizard see “Procedure Debug Log” on page 1572.
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Dialog Workshop

When an off the shelf dialog won’t cut do, you can build your own using dialogs using standard Panorama
forms and the Dialog Workshop wizard. This wizard analyzes your form and writes the basic code for that
form for you. It also let’s you try out your dialog before you actually commit the code to your database. 

To learn more about this wizard see “Custom Dialogs” on page 1744.
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Dropalyzer

The Dropalyzer wizard is a handy tool for analyzing, writing and testing drag and drop procedures.When
you first open this wizard it is completely blank, but you can drag anything you want onto this wizard and it
will display some information about what was dropped. The illustration below shows the display if you drop
two folders from the Finder onto the Dropalyzer wizard.

To learn more about this wizard see “The Dropalyzer Wizard” on page 1899.
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Elastic Picture Workshop

Many forms require borders, buttons and widgets need to be used over and over again but with different
sizes. Any image can be stretched with the Scale to Fit option, but the result is often a distorted image. The
Elastic Picture Workshop wizard can be used to add stretching information to an image so that it won’t be
distorted when it is stretched.

To learn more about this wizard see “Elastic Pictures” on page 928.
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Resource Menu Editor

Resource based custom menus allow you to completely or partially override Panorama’s standard menus
(see “Custom Menus (Resource Based)” on page 1606). They also allow you to create submenus, attach icons,
checkmarks, and other graphics to a menu, and to change menus on the fly. To create custom menus you’ll
need to create menu resources in a resource file. One way to do this is with Panorama’s Resource Menu Edi-
tor, a database that is installed along with Panorama.

To learn more about this wizard see “Preparing a Resource File” on page 1607.

Variables

Global, fileglobal and permanent variables can be displayed and modified with the Variables wizard.

To learn more about this wizard see “Displaying and Changing Variables” on page 1504.

type of variable database
name of variable
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Documentation Wizards

The wizards in this submenu provide access to documentation, help and tutorials.

Panorama Handbook

This wizard launches Adobe Acrobat and opens the Panorama Handbook (what you are reading right now!).
If you installed the documentation on your hard drive the wizard will open the Handbook directly from the
hard drive. If the documentation is not installed it will open the Handbook from the CD. If the documenta-
tion is not installed and the CD is not in the drive an alert will appear and Adobe Acrobat will not launch.
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Panorama Movies

The Panorama Movies wizard allows you to view the QuickTime training movies included on the Panorama
CD. You can also watch these movies using the standard QuickTime MoviePlayer, but if you use the Pan-
orama Movies wizard you will be able to jump directly to any topic.
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When you open the wizard a list of the available movies will appear. (If the CD is not in the drive an alert will
appear, and the wizard will shut down.)

Click on the movie you want to watch. The beginning of the movie will appear, along with a window with a
list of topics within the window. Use the control panel at the bottom of the movie window to control the
movie.

press to start/pause the movie

current location within movie (can be dragged into a new spot)

step forward/back a few frames
adjust audio volume
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The Movie Bookmarks window displays a table of contents for the movie. It shows where you are within the
movie and allows you to jump directly to any topic within the movie.

When you are done watching a movie you can either close the movie window or press the Back to Movie
Directory button (the Bookmarks window will automatically close in either case).

You can now select a different movie or go back to the main installer movie. As long as the wizard is open
Panorama will remember your spot within each movie you have watched. If you go back to a movie you
have opened previously the remove will resume from the spot where you left off.

ccurrent topic

running time within movie

click on any topic to jump to it

click here when finished watching the movie
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Programming Reference

The Programming Reference contains detailed reference information for every statement and function avail-
able in Panorama, as well as introductory information about related topics. Overall there are over 650 topics
and over 900 pages of information. Each topic is cross-linked to other related topics for easy access, and the
database is fully searchable.

For more information on using the Programming Reference see “Programming Reference Wizard” on
page 1489 or simply open the wizard (the first page contains instructions).
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Form Tools Wizards

The wizards in this submenu help with working with forms.

Font Usage

This wizard displays a list of all fonts used in a database’s forms. All fonts will be listed except for Geneva,
Chicago, New York and Monaco (Macintosh) or Alpine, City, Yankee and Block (Windows).

See “Font” on page 657 to learn how to select the fonts used in a form.

Form Explorer

The Form Explorer wizard is an alternative tool for examining and (to some extent) modifying forms. The
wizard displays a list of objects in a form, and displays the attributes for an object when you click on it. It’s a
great tool for exploring a form you are not familiar with to find out things like “what procedure is triggered
by that button” or “what variable is being edited in that box”?

To learn more about this wizard see “Using the Form Explorer Wizard” on page 711.
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Icons & Backgrounds

Panorama includes a number of resource based images within the application itself. Most of these are used
by Panorama in various windows and dialogs, but they are available for use in your databases also. To see a
list of these images open the Icons & Backgrounds wizard in the Form Tools submenu of the Wizard menu.

To learn more about this wizard and using these images see “Displaying Images from Resource Files” on
page 921.

Window Size

The Window Size wizard measures the size of the currently open window.

To learn more about measuring window size see “Measuring a Window (Window Size Wizard)” on page 333.

Window Tweak

Using the Window Tweak wizard you can enable and disable the tool palette and scroll bars in a form.

To learn all the details see “Turning Window Components On and Off (Window Tweak Wizard)” on
page 331.
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Internet Wizards

The wizards in this submenu bridge between Panorama and content on the Internet. Your computer must be
connected to the Internet to use these wizards.

Address Info

This wizard gets information about US addresses and zip codes. If you enter a zip code it will display infor-
mation about that zip code, including the city, state, county, area code, time zone, latitude and longitude, and
the FIPS and MSA code. If you enter a full address it will display the zip+4 code and carrier route, and will
check to make sure that this is a valid address according to the US Post Office.

To display information about a zip code, type in the zip code and press the Get Address Info checkbox.

The wizard will check on the Internet and display the information about this zip code.

click to display zip code information
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To check and display information about an address, enter the address and press the Get Address Info button.

The wizard checks the Internet and displays the information (including looking up the nine digit zip code,
since no zip code was supplied). Since the Use USPS Corrected Address option is checked, the wizard
rewrites the address itself to conform to US Post Office standards (for example 1807 Abbott Street is rewritten
as 1807 ABBOT ST).

If the address is not valid it will turn red when you press the Get Address Info button. In this case there is no
such address as 18070 Abbot Street.
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The Address Info wizard also understands VCards, so you can drag from any database or application that
supports VCards. For example, you can drag from Apple’s Address Book application, as shown here.

When the address is dropped on the wizard it will display the additional address information.

You can build the address checking functionality of this wizard directly into your own databases. See “Gen-
eral Zip Code Information” on page 1870 and “Street Address Information” on page 1871 to learn the details.
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Bulk Email

The Bulk Email wizard makes it easy to send and keep track of bulk emails. It keeps all of the previous e-
mails you've sent organized, and can automatically extract e-mail addresses from one or more other data-
bases. The wizard has two primary windows. The Bulk Email window displays a single e-mail message, and
allows you to configure and modify that message. The History window displays a list of the previous e-mails.

To create a new e-mail message use the New Record tool. Use the keyboard to fill in the date (defaults to
today's date), subject, body of the message and any notes. You may also want to fill in the From e-mail
address if it has changed.

The Database menu displays a list of all the other open databases. Select the database that contains the e-mail
addresses you want to send to.
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The Fields menu displays a list of the fields in the selected database. Select the field that contains the e-mail
addresses you want to send to. (Note: If you have already used the Generic Fields wizard to define an e-mail
field the wizard will select this field automatically. You can, however, choose a different field if you wish.)

Note: If you are working with a database that has its generic fields set up (see ““Generic” Fields” on
page 398) Panorama will automatically ask if you want to create a new e-mail message when you open the
Bulk Email wizard. If you click Yes the wizard will automatically add a new record and set up the Date,
Database and Fields options for you.

Make sure that the correct data is selected in the database that contains the e-mail addresses. For example, if
you only want to send e-mails to recipients in New Jersey with blue eyes, make sure that only those records
are currently selected.

Before you actually send the e-mail you may want to open the Channels Wizard to double check to that the
correct e-mail module is selected and configured (see “Channels” on page 54).

To actually send the bulk e-mail choose Send Bulk Email from the Mail menu. After the e-mail has been
transmitted the wizard will update the log for this e-mail.

The first line of the log entry records the date, number of recipients, database, and field used for this mailing.
The subsequent lines contain each e-mail address that received the mailing, so you have a permanent record
(of course you can delete this information if you want to).
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If you later decide to send this message to additional e-mail addresses (perhaps from a different selection or a
different database) the wizard will check the log before sending the e-mails. Any e-mail addresses that have
already received the mailing will not be sent a duplicate copy. This makes it easy to send a large mailing
based on several lists.

You can build the e-mail sending functionality of this wizard directly into your own databases. See “Sending
E-Mail” on page 1877 to learn the details.

Fedex Tracking

This wizard helps you track the progress of FedEx shipments. To use this wizard just enter the tracking num-
ber.

The wizard will display the status of this package. In this case the package has been delivered to the recipient.

You can build the package tracking functionality of this wizard directly into your own databases. See “FedEx
Shipment Tracking” on page 1873 to learn the details.

enter tracking number check FedEx for updated status
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URL Wizard

The URL Wizard scans all of the fields in the current record looking for URL's (web and e-mail addresses). If
it finds any, you can double click on them to open the corresponding web page or create a new e-mail mes-
sage. To illustrate the URL Wizard we'll use the Mini Contacts wizard, which comes with Panorama. The
records in this database contain addresses, phone numbers, e-mail addresses and web site URLs.

Open the URL Wizard to scan this record for internet addresses. As you can see, this record contains two: an
e-mail address and a web site.
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To open representative Everett's web site (using your default browser), double click on the first URL.

To send an e-mail to representative Everett double click on the e-mail address. The wizard will automatically
open your default e-mail client and create a new pre-addressed message. (In case you are wondering, the
default e-mail client on our system is MailSmith from Bare Bones Software, shown below.)
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Each time you choose URL Wizard from the Wizard menu the wizard will re-scan the current record. Another
way to re-scan is to press the re-scan button in the upper right hand corner of the window.

This is useful when you've moved to a different record or a different database and want to check for URLs in
the new location.

You can build the functionality of this wizard directly into your own databases. See “Displaying a Web Page”
on page 1874 and “Sending E-Mail” on page 1877 to learn the details.

White Pages

The White Pages wizard allows you to look up addresses and phone numbers.

To search for a person, enter as much information as you know. At a minimum, you must enter at least a par-
tial last name. The more information you enter, the better the chance that the wizard will be able to locate the
person.

re-scan button
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When you’re ready to go, press the Search button. The wizard will display any people that match the criteria
you have entered. In this case there are three people named Furnare in California.
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If you hold down the Control key (Macintosh) or right click (Windows) on an entry a context menu will
appear.
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Choose an item from this menu to perform the operation on the selected address.

Menu Command Description

Select This Name
This command is useful if you have entered a partial name. If you find a person 
with the name you are looking for in the list, choose this menu command to see if 
there is anyone else with this name in the list.

Select This Name & City Like the Select This Name command, but only shows entries with the same name in 
the same city.

Display Map

Displays a map showing this address in a separate window.

Open Web Map

Opens your web browser and displays a map with this address.

Dial Phone Dials this phone number using the currently selected dialing (see “Channels” on 
page 54).

Copy Label Copies the address to the clipboard in standard label format, suitable for pasting 
into a text editor or word processor program.

Copy VCard Copies the address to the clipboard in VCard format.

Export VCard… Exports the address into a VCard file that can be imported by other VCard compati-
ble programs.
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You can also drag the person from the wizard to any VCard compatible database or application, for example
Apple’s Address Book program or the Mini Correspondence wizard, as shown here.
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If your search turns up more than a few results, the wizard will only download the first ten. For example,
there are sixty people named Jack Smith listed in Arizona, but the wizard initially displays only ten of them.

If the person you are looking for isn’t listed in the first ten you can press the more button to display an addi-
tional ten.
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If you hold down the Option key while you click the more button the wizard will load all of the remaining
addresses from the Internet. This may take a few seconds.

As you display more and more people, you may find that there is less information displayed for each person.
This is a function of the web site that Panorama is retrieving the information from. Sometimes you can dis-
play this additional information by narrowing your search. For example in the listing for all of Arizona there
is no phone number listed for Jack Smith in Scottsdale. Narrowing the search to only include Scottsdale turns
up the phone number and zip code.
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If you try a really broad search that turns up hundreds or even thousands of matches the wizard will only
indicate that there are 100 matches. For example, a search for every Smith in Arizona turns up 100 matches,
even though there are thousands of Smith’s living there. If your search turns up 100 matches, try using a nar-
rower search.

You can build the functionality of this wizard directly into your own databases. See “White Pages” on
page 1872 to learn the details.

Mini Application Wizards

The databases in this category provide basic tools for organizing personal information. Compared to many
personal information managers (PIMs) that are available these tools are very basic. However, these databases
do illustrate how to create such tools in Panorama, and also have the advantage that you can adapt and cus-
tomize them exactly to your own needs.

Mini Contacts Wizard

The Mini Contacts wizard is a very simple database for storing names, addresses and phone numbers.
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To edit any item simply click or drag on the item and begin editing. (The Mini Contacts database uses Text
Editor SuperObjects for editing instead of data cells, so there is no expandable input window. See “Types of
Data Editing Objects” on page 760 for more information). Press the Enter or Tab keys when you are finished
editing an item.

To add a new record use the Add New Record tool or the Add New Record command in the Edit menu.

To search for text anywhere within in the database choose the Find command from the Search menu. The
database will ask you what you want to search for.

When you press the OK button Panorama will search all of the fields in the database for the word or phrase
that has been typed in. (To learn how this search was set up see “A Handy Universal Find Procedure” on
page 1806). In this case a record has been found that contains birmingham in the City field.

To find additional occurrences of the word or phrase use the Find Next command. You may continue to use
this command until you have located every occurrence of the word or phrase in the database.
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The Mini Contacts form is elastic and can be expanded up to the full screen size. See “Elastic Forms” on
page 1040 to learn how to create an elastic form.
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To open the data sheet use the View menu (see “Switching Between Views” on page 350). If you want the
data sheet to open in its own separate window hold down the Control key (Macintosh) or Alt key (Windows)
while you select from the menu (see “Opening More Than One Window Per Database” on page 351).

You may notice that in the data sheet the name is split up into five separate fields, while in the form the name
appears to be a single field. The database has been set up to make this conversion automatically. When you
enter a name into the form Panorama automatically splits it up into five separate components (Prefix, First,
Middle, Last and Suffix) and when a name is displayed in the form these components are automatically com-
bined together. To learn how this was set up see “Natural Data Entry” on page 1783 and “Natural Data Dis-
play” on page 1781.



Page 46 Panorama Handbook
Mini Calendar Wizard

The Mini Calendar wizard is a very simple database for keeping track of dates and events.

If a day has a black triangle in the upper left hand corner then there is a note attached to that day. Click on the
day to see and/or edit the note.

To add a new note simply click on the day, then click in the note area and begin typing. Press the Enter key
when you are done.
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To search for a particular item press the Find button or choose Find from the Search menu.

Press OK to locate the word or phrase. Panorama will search the database in date order.

If you think that there might be additional occurrences of this word or phrase you can press the Next button
or choose Find Next from the Search menu.

If you’d like to see the data sheet for this database you can use the View menu or you can simply press the
Data Sheet button.

You can use the data sheet to add, edit or delete calendar entries.
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Mini Correspondence Wizard

The Mini Correspondence database may be used for general correspondence (letters, memos, etc.) and to
create mail merge letters that are customized and sent to a group of recipients. The wizard can be linked to
any database that contains names and addresses to make it easy to create individual or mail-merge letters.

To learn more about this wizard see “Using the Mini Correspondence Wizard” on page 855.
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Mini Statistics Wizard

The Mini Statistics wizard can calculate the mean (average), median, and standard deviation of a data set. In
addition the wizard can plot a normalized chart showing how the data is distributed around the mean. You
can easily see how this distribution compares with the standard gaussian distribution (the famous bell
shaped curve). Here is an example of an analysis performed by this wizard.

To lean more about this wizard see “The Mini Statistics Wizard” on page 556.

Stopwatch Wizard

The Stopwatch wizard is a simple timer.

Press the Start button to start or re-start the timer. Press the Stop button to stop the timer. Press the Reset but-
ton to reset the timer to 0:00:00.
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If you need more than one timer you can make a copy of the Stopwatch database file. To make the copy Quit
from Panorama, open the Wizard folder and make one or more copies of the Stopwatch database. When you
re-open Panorama you can start and stop each timer separately.

When a stopwatch is running the display will usually update once every second as long as Panorama is run-
ning and is the frontmost application. However, the display will not update when you are actually editing
text. It also will not update when the you are editing a form or a procedure.

Task Timer Wizard

The Task Timer wizard allows you to keep track of the time you spend at different tasks. You can set up a list
of tasks to track.

When you start a task that you want to time click anywhere on the line for that time. An animated clock will
appear to indicate that you are timing this task.
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When you are done with the task you can click the line again or click the Stop Timer button at the bottom of
the window. If you are starting a new task you can simply click on the new task to switch the timer. You can
also type notes in the top section of the window. These notes will be included in the time log.

You can close the Task Timer or even quit from Panorama without affecting the timer. When you re-open the
timer you will see that it has continued to keep track of the time of the last task started (if any). The task time
updates when the Task Timer is in front, but not when any other window is in front. The time will update
when you bring the Task Timer window forward.

Click the Time Log button to view a log of the activities you have timed.

Double click to edit the Notes for a time log entry. You can expand the Input Box to show as much text as you
want (see “Expanding the Input Box” on page 439).
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Use the Crosstabs menu to open a crosstab that summarizes the time log data by day, week, or month.

To edit the list of tasks click on the Edit Task List button. You can type in any tasks you want, in any order.
It’s ok to remove a task that you have been timing — this does not affect any tasks you have already logged.
When you’ve made all of the changes to the task list click the Task Palette button to switch back to the main
timer window.
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The Task Timer can display the cumulative time for each task for the current day, week, or month. Use the
pop-up menu to select the period you want to use. The display will immediately update to reflect your
choice.
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Preferences Wizards

The wizards in this submenu set up preferences and options for Panorama and for individual databases.

Channels

Some Panorama applications require a connection between Panorama and an external program or resource.
Panorama allows you to set up channels as a conduit between Panorama and the external resource. For
example, suppose you have a Panorama application that needs to send an e-mail. To do that Panorama will
need to make a connection with the Internet software installed on your computer. Panorama uses the Chan-
nel Wizard to configure that connection.

Panorma has special programming statements that take advantage of the connections set up by different
channels. The table below lists each type of channel and the statements that use the connection set up by that
channel.

The exact operation of each of these statements will vary depending on how you have configured each chan-
nel. For example, the dialphone statement can dial the phone by creating tones on your computer speaker,
by using a modem, with a bluetooth connection, or over the Internet if you have a Vonage phone. The pro-
grammer that writes the dialphone statement into his or her program doesn’t know or care how the dialing
is actually performed, he or she relies on the channel to do that job for them.

Even if you are not a programmer you may find that channels are useful for you. Many of the wizards and
sample databases that are included with Panorama are already programmed to use channels. For example,
the White Pages wizard can automatically dial the phone using the Dial channel, while the Bulk Email wiz-
ard will send mass e-mails using the Email channel. All you need to do is configure the channels for your
needs and this wizards will be ready to go.

Note: The table above will grow as more channels become available. Check the Channels wizard for any
additional channels that may have been added since this documentation was last updated. (You can also
write your own channels, see “Writing Your Own Channel Modules” on page 1977).

Channel Statement Description

Dial
dialphone Dial the phone, adding prefixes, country codes and area codes as 

needed.

dialdigits Dial one or more digits exactly as specified.

Email

sendoneemail Send a single e-mail message.

sendbulkemail Send multiple e-mail messages, one for each currently selected 
record in a database.

sendarrayemail Send multiple e-mail messages, one for each element of an array.

sendemail Send multiple e-mail messages with advanced options.

WhitePages querywhitepages Look up a person’s address and/or phone number.

ZipInfo zipinfo Look up information about a zip code — city, state, county, area 
code, time zone, etc.
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Selecting and Configuring a Channel

Each channel must be configured before it can be used. This configuration is done with the Channels wizard.
When you first open this wizard it displays the types of channels available.

Each channel shows the channel name followed by the currently active module for that channel. For example,
if I was to ask Panorama to dial the phone right now, it would do so through my Vonage internet phone con-
nection. If I was to ask Panorama to send and e-mail, it would do so through 24 Email OSAX, a shareware
application I have purchased for sending e-mail.

The Channels wizard allows you to change the active module. For example, I might want to dial the phone
using my modem instead through the Vonage internet phone connection. To see the choices available I click
on the Dial channel.
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There are four different modules available for dialing. I know that I can use the ABDialer option to dial the
phone with my modem, so I click on that.

When you select a module the wizard displays a description of the module in the bottom section of the wiz-
ard. In this case the description indicates that ABDialer is a program that must be purchased separately, and
that it can dial through the modem, speaker, Bluetooth or Irda. Since this is a separate program it has it’s own
configuration, which I can set up by launching the ABDialer application.
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Getting back to Panorama, most modules have one or more settings that need to be configured before you
can use the module. Click to select a particular setting, then type in the settings value in the box on the right.
For example, suppose your phone is on a PBX and you need to dial 9 for an outside line. To set this up, click
on the Prefix= option, then type 9 as shown below.

Repeat until you have typed in all of the necessary settings.

Finding More Information about a Module

Many channel modules rely on other software or hardware to perform their operations. The bookmarks
menu lists links to web sites that contain additional information about additional items you'll need to use this
module.

Selecting a link will automatically open your web browser to the specified page.
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Generic Fields

Databases come in all sizes and shapes. Generic fields allow different databases to share information even if
they have different field names or slightly different configurations. For example, one database may store
company names in a field named Company, while another may have a similar field named Organization. By
setting up generic fields for each database, you build a bridge so that Panorama knows that these two fields,
though named differently, contain the same type of information. Once this bridge is built Panorama can
exchange data between these two databases (for example by drag and drop), and between Panorama and
other applications that can share information (for example Apple’s Address Book). Panorama includes a spe-
cial wizard for setting up generic fields for any database that contains contact information.

To learn how to use this wizard see ““Generic” Fields” on page 398.

Hotkey Manager

The Hotkey Manager Wizard allows you to set up database actions that will occur in response to different
keystrokes and keystroke combinations. Each hotkey may be set up as a universal hotkey (active for all data-
bases) or it may be made specific to a particular database. When the Hotkey Manager is first opened it dis-
plays the universal hotkeys that are already defined, if any.
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The window is divided into two columns. The first column displays each keystroke combination. The right
side displays the action that will be performed when this keystroke combination is pressed.

Adding a New Universal Hotkey

To create a new universal hotkey, choose New Hotkey from the Hotkey menu.

This dialog is divided into two sections. The section on the left displays the keystroke combination. To specify
the combination simply press the key or key combination you want to use. You may use any character on the
keyboard, optionally combined with the Shift, Control, Option, Command or Alt keys. (The Option and
Command keys are available only on the Macintosh, the Alt key is available only on the PC.) If you decide
you want to change the key combination, simply type another key or key combination. You can change the
hot key as many times as you like. Each time you press a key or key combination the left side of the dialog
will update to display your selection.
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The right side of the dialog is a scrolling list. Select the action you want to perform from this list. (You can also
set up a custom action -- more on that later). The actions in the list are all “universal” actions that could apply
no matter what database is open (for example, opening a wizard).

Once the action is selected, press the Ok button. The new Hotkey is ready to use immediately, and will be
active no matter which Panorama database is currently active. In this case you can now press Control-U at
any time to open the URL Wizard.

Creating a Database Specific Hotkey

To create a database specific hotkey, first choose the database from the Database menu.

The wizard will display any hotkeys that have already been specifically defined for this database.
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Now use the New Hotkey command in the Hotkey menu to define a new hotkey. The command works
exactly the same as it did before, but the new hotkey it creates will be specific to the current database instead
of universal. You'll also notice that there are more action choices on the right hand side of the dialog. In addi-
tion to the universal actions, the dialog also now lists actions that are specific to this database. For example,
you can set up the hotkey to trigger any procedure in the database, as shown in this example.

When you press Ok the new hotkey is immediately defined and ready to use.

Notice that in this example the Control-F hotkey has been defined twice - once as a universal hotkey (to open
the Live Clairvoyance wizard) and once as a database specific hotkey. In this case the database specific hot-
key overrides the universal hotkey. As long as the My Address Book database is the active database (the top-
most window) Control-F will activate the Find in Any Field procedure. When any other database is active
Control-F will open the Live Clairvoyance wizard.

Database specific hotkeys are not stored in the wizard -- they are stored in the database itself. Your new hot-
key will not be permanently saved until you save this database itself.
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Custom Hotkey Actions

Normally hotkey actions are selected from the list in the hotkey configuration dialog. Sometimes, however,
you may want to create a hotkey that performs a custom action that is not on the list. To do this, first create
the hotkey the normal way. Since you are going to create a custom action, it doesn't matter which action you
select.

Once the hotkey is created, select it and choose the Custom Code command from the Hotkey menu. This
command opens a dialog that allows you to type in any procedure you like for the custom action. The exam-
ple below shows how this dialog can be used to create a database specific hotkey that copies a mailing label
into the clipboard, so that it can be pasted into another database or application. (Of course you could also cre-
ate a procedure that did this, then select the procedure in the normal Hotkey Configuration dialog.)

When you press OK the hotkey list will show your new custom action.

If you have created a universal hotkey, remember that this action may be performed with any database
active. Be sure not to include any code that is specific to a particular database. Of course this isn't a problem if
you are creating a database specific hotkey.

Speech Wizard

The Speech Wizard allows you to add speech synthesis to any Panorama database on a Macintosh computer.
This allows Panorama to “read back” your data for voiced based data verification and auditing. Using a sim-
ple user interface you can create one or more scripts for reading back the information in a database.
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Using Speech Scripts

The Address Book example database that comes with Panorama (in the Guided Tour folder) already has sev-
eral speech scripts set up. To try these out, first open this database.

Now open the Speech Wizard. When you open the wizard, it displays the currently selected script (if any), as
shown below.

To hear Panorama read back the name and address of the currently visible person, choose Speak Script from
the Script menu. Notice that the script knows how to correctly pronounce abbreviations like Mr., S. and VT.

The Script menu allows you to select and manage scripts. Two scripts have been defined for this database
Name & Address and Phone Number.

To switch to a different script simply select that script from the menu (for example Phone Number). You can
then read back using that script or modify the script you have chosen.
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Speaking Scripts with a Hotkey

The Hotkey manager comes pre-configured to speak the current script in any database when you press the
F11 key.

This means that in any database you can press the F11 key to speak the current record (assuming a script has
been set up). You can change the key assigned to this action using the Hotkey Manager wizard. You can
change which script will be spoken using the Script menu (in the Speech Wizard). You can also set up a data-
base specific hotkey to speak a specific script. Simply choose the script you want to use from the action list in
the Hotkey Configuration dialog.

See the Hotkey Manager for more information on setting up hot keys (“Hotkey Manager” on page 58).
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Creating a New Script

To create a new script use the New Script command in the Script menu. We'll illustrate this with the Corpo-
rate Checkbook database, which is also in the Guided Tour folder.

Our goal will be to create a script that reads the check data aloud like this:

Check number five-sixty-four to Valley Bell for three-hundred twenty- three dollars and 
twenty-five cents.

Start by choosing New Script from the Script menu, and assigning the new script a name.

Press OK to create a new, empty script.
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Using the Data Menu

The Data menu is the primary method you'll use to create and modify scripts. This menu allows you to add a
word or phrase, to insert or delete rows, and to add any field to the script. The bottom portion of this menu
lists all of the fields in the current database. Each field has a submenu that lists the available formats for that
field. For example, a numeric field like the Check number (shown below) can be spoken as Words, Digits,
Digit Pairs, Dollars or Dollars and Cents.

For this script we want to start by speaking the phrase check number, so you'll select the Word or Phrase
menu item. A dialog appears for you to type in the word or phrase.

When you press the OK button this item is added to the script.
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Next the script needs to speak the actual check number itself. Select Check from the Data menu, then select
DigitPairs from the submenu.

This item will be added to the script.

To complete the script perform the following steps.

• Select Word or Phrase and enter to.
• Select Pay to > Words.
• Select Word or Phrase and enter for.
• Select Debit > DollarsAndCents.

The finished script will look like this:

You can use the Speak Script command to try out your new script.
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Speech Data Styles

Each type of data (text, numeric, date) has one or more styles that you can use to read the data. The table
below lists and describes each of these styles.

Data Type Statement Description

TEXT

speakwords The text is spoken using normal English.

speakdigits
The data is spoken in English, but if the data contains any numbers they will be 
spoken as individual digits. For example, 4892 will be spoken as four eight nine 
two.

speakdigitpairs The data is spoken in English, but if there are any numbers they will be spoken 
as digit pairs. For example, 4892 will be spoken as forty-eight ninety-two.

speakletters The data is spoken letter by letter, including upper and lower case. For example 
Jim will be spoken as upper case J, lower case I, lower case M.

speakcharacters The data is spoken letter by letter. For example April will be spoken as A P R I 
L.

speakcharactersslowly The data is spoken letter by letter, with a delay between each letter. For example 
April will be spoken as A; P; R; I; L.

speakaddress
The data is spoken in English, but any official USPS abbreviations are expanded 
as the text is spoken. For example S or S. is expanded to South, while Bl. is 
expanded to Boulevard. Any numbers in the text are spoken as digit pairs.

speakstate
If the text is a two letter abbreviation of a U.S. state it will be spoken as the full 
name. For example CA will be spoken as California, while WV will be spoken 
as West Virginia.

speakphonenumber The first ten digits in the text are spoken as a phone number, along with any 
extension after that.

NUMBER

speakwords The number is spelled out. For example, 4892 will be spoken as four-thousand 
eight-hundred and ninety-two.

speakdigits The number is spoken as individual digits. For example, 4892 will be spoken as 
four eight nine two.

speakdigitpairs The number is spoken as digit pairs. For example, 4892 will be spoken as forty-
eight ninety-two.

speakdollars The integer portion of the number is spelled out, followed by the word Dollars. 
For example 378.93 will be spoken as Three-hundred seventy-eight dollars. 

speakdollarsandcents

The integer portion of the number is spelled out, followed by the word Dollars, 
followed by the two digits after the decimal point, followed by the word Cents. 
For example 378.93 will be spoken as Three-hundred seventy-eight dollars and 
ninety-three cents.

DATE speakdate The date is spelled out. For example 4/18/04 is spoken as April eighteenth, 
2004.
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Advanced Mode vs. Simple Mode

The Speech Wizard actually has two modes: Simple Mode and Advanced Mode. So far we have only dis-
cussed the simple mode, which allows you to create and modify the script with the Data menu. Advanced
mode allows you to modify the script directly, using a text editor.

To edit the script, simply click anywhere in the text and begin typing. You can also select text just as you
would with any other text editing application.

In advanced mode, the script is actually a Panorama procedure. You can type any Panorama procedure code
you like into the script, including if, loop, and call statements, as well as using variables.

Saving a Script

The script wizard doesn't have any command for saving a script. That's because the script is not saved as part
of the script wizard. Instead it is saved as part of the database itself. To save the script you need to save the
original database that the script is attached to.

Because the script is saved along with the database, it doesn't matter if you move the database to a different
folder or even a different computer. The script will remain as part of the database no matter where it goes. (Of
course you can always use the Delete Script command to remove it.
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Utilities Wizards

The wizards in this submenu provide tools to make working with Panorama databases easier. You don’t need
to use these wizards, but they can make some common database tasks easier.

Arrange Windows Wizard

The Arrange Windows wizard allows you to arrange all of the open Panorama windows into a regular pat-
tern, either side by side (tiled) or piled on top of each other with a slight offset. This illustration shows an
example of window tiling.

Here is an example of window stacking.

To learn more about this wizard see “Arranging All Open Windows at Once (Tiling and Stacking)” on
page 337.
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Disk Permissions

This wizard is for Mac OS X only. The wizard displays information about each of the disk drives currently
mounted on your computer. For each drive the wizard lists the owner, the group, and the operations that can
be performed by each class of user.For each class there are three possible operations: R (read), W (write), and
X (execute). If the box is green, the operation is allowed. If it is red, the operation is not allowed.

This wizard is included primarily to assist the ProVUE Development technical staff with debugging unusual
installation problems. If you have difficulty installing Panorama, our technical support staff may ask you to
use this wizard to help diagnose the problem. If the permissions are incorrect, you can change them using the
Terminal (recommended for UNIX experts only) or with a freeware program named BatChmod. To find out
more about BatChmod (and possibly download the program), go to the BatChmod web site:

http://macchampion.com/arbysoft/

Open Database

The standard techniques for opening a database (double clicking, Open File dialog, Favorite Databases wiz-
ard, etc.) will work fine in 99,999 of 100,000 cases. Sometimes, however, you may need to use a more special-
ized technique to open a database. For example, if a database has lost it’s MacOS type/creator information
(perhaps by sending it through an e-mail client that doesn’t properly support this information, a common
problem) the standard techniques will not work. In other cases you may need to open a database but bypass
the normal initialization of that database. The Open Database wizard is included for these special needs.

To learn more about these wizards see “Advanced Database Opening Techniques” on page 246.
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Platform Converter

The Platform Converter converts databases between platforms and versions. It doesn’t actually modify the
contents of files, but it does control how databases interact with the operating system. You can use the plat-
form converter to convert Panorama 3.1 databases for use with Panorama V, and also to add the .pan exten-
sion required to use databases on Windows.

For more information about this wizard see “Platform Converter Wizard” on page 1984.
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Summaries & Outline Wizard

The Summaries & Outline Wizard automates the process of calculating summaries (see “3-Step Summariz-
ing” on page 521). You can use this wizard to rapidly take pages and pages of information and distill them
down into concise, useful summaries.

To learn more about this wizard see “The Summaries & Outlines Wizard” on page 551.

Text Export Wizard

The Text Export Wizard allows you to export any database as a text file. Usually you’ll do this when you
want to transfer information to another application. The wizard allows you to specify the order of the fields
being exported, and to manipulate the data as it is being exported (converting it to upper case, for example,
or combining several database fields into one export field). The wizard can even be used to convert the data-
base into an HTML table so that it can be published on the web (see “Exporting HTML Tables” on page 306).

To learn more about this wizard see “Exporting with the Text Export Wizard” on page 297.
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Text Import Wizard

The Text Import Wizard allows you to import almost any text file into a database. You’ll use this wizard to
help transfer data from other applications (Access, FileMaker, etc.) into Panorama. The data can be imported
even if the arrangement of fields in the text file is completely different than the arrangement of fields in the
database itself.

x

To learn more about importing data with this wizard see “Using the Text Import Wizard” on page 285.



Page 75
VCard Wizard

Generic fields allow you to transfer data between the database and other databases that also have generic
fields, or between the database and applications that support vCards. For example an address could be cop-
ied to Apple’s address book, or used to display a map. A phone number can be used to actually dial the
phone, or an e-mail address to send an e-mail. The slickest way to use generic fields is to program them into
your database itself (see “VCard Drag and Drop” on page 1904). However, it’s not necessary to do any pro-
gramming to use generic fields. The VCard Wizard allows you to use generic fields without any program-
ming at all. When you first open this wizard it will display the generic data from the current database, as
shown below. (If the current database doesn’t have any generic fields, it will display an error message.)

With the VCard Wizard you can:

• Drag contact information back and forth between this database and other databases or applications.
• Import or export groups of VCards.
• Display a map of the currently displayed address
• Send an e-mail to the currently displayed contact
• Automatically dial the phone

To learn more about this wizard see “Using Generic Fields with the VCard Wizard” on page 404.

original database

VCard wizard displays the same information
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Business Demo Files

The demo databases in this category show examples of how Panorama can be used to build common busi-
ness applications. To open these files open the Favorite Databases wizard and select the Business group.

The databases in this category use some fairly advanced Panorama techniques.

Books (Product Catalog)

This database demonstrates one way to build a product catalog using Panorama.

The database itself is fairly basic, as you can see if you use the View menu to open the data sheet (see “Open-
ing More Than One Window Per Database” on page 351).
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Displaying the Book Covers

The database uses Flash Art to display the book covers (see “Flash Art™” on page 876). The images are not
stored in RAM as part of the database but are kept as separate files in a folder named Book Covers (see “Dis-
playing Images Directly From Disk Files” on page 895). Each image has been named according to the ISBN
number of the corresponding book.

The Flash Art SuperObject uses a formula to convert the ISBN number stored in the database into the correct
image name (see “Displaying Images in a Different Folder (Directory)” on page 897).

Navigation with a List SuperObject

One unusual aspect of this database is the use of a List SuperObject (see “List SuperObjects” on page 997) for
navigating within the database. This is a fairly advanced technique that is probably best attempted after you
have some experience with creating Panorama procedures (see “Procedures” on page 1467).

click in list to move to the corresponding record
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The default for this list is to display the name of every book in the database (see “List Options” on page 1001
for more information about this dialog). The list also contains the ISBN number for each book, but the ISBN
number is hidden because it is after the null character (created by the chr(0) function — see ““Hiding” Part
of a List Item” on page 1015).

When you click on one of the items in the list the .ListClick procedure is triggered. This procedure in turn
calls a subroutine procedure named .Browse (see “Subroutines” on page 1512).



Page 79
The .Browse procedure uses the array( function (see “Text Arrays” on page 1364) to extract the hidden
ISBN number in the currentBook variable (this variable was set up using the configuration dialog for the list
shown above). It then uses the find statement to locate the record corresponding to the book that was
clicked on (see “Finding Information” on page 1805). The end result is that when you click on a book in the
list, the information for that book appears.

You may have noticed that the .ListClick procedure contains a bunch of additional code. This code allows
you to drag an item from the catalog onto an invoice, and is discussed as part of the Invoice demo file.
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Catalog “Search Engine”

The catalog database has a “search engine” that makes it easy to locate items within the database. To search,
click in the search area and type in a word or phrase, in this case web.

When you press the Enter key the database will search for books that contain the word or phrase and display
them in the list. The word or phrase may be anywhere in the record - in the title, the description, the author or
publisher’s name, anywhere.

How does this search engine work? The top of the form contains a Text Editor SuperObject (see “Text Editor
SuperObject” on page 767) for you to type the word or phrase into. The word or phrase you type goes into
the variable named bookSearch.
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When you press the Enter key a procedure named .BookSearch is automatically triggered. Here is the code
for that procedure.

The procedure uses the arraybuild statement to scan the database searching for records that match the
word or phrase in the bookSearch variable (see “Building an Array from a Database” on page 1847). It then
uses the superobject statement to send a command to the list object telling it to re-display itself with the
new list (see “List SuperObject™ Commands” on page 1955). You’ll notice that for this to work the list object
must be named Book List (see “Object Type/Object Name” on page 661).
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Invoices (Line Items)

This database demonstrates how to create an invoice with line item fields (see “Repeating Fields (Line
Items)” on page 390). You’ve already learned how to create such a file in the Step-by-Step tutorials (see “Les-
son 3: Building an Invoice Database” on page 169).
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Invoices (Arrays)

This databases demonstrates an alternate technique for handling repeating detail lines in an invoice. Instead
of using line item fields, this database stores repeating detail items in a single field using a text array. To
understand how this database works you’ll definitely need to study text arrays, so you may want to turn to
“Text Arrays” on page 1364 if you are not already familiar with them.

Setting up repeating items with a text array takes more programming than using line item fields. However,
using a text array eliminates the need to determine the maximum number of items in advance. An invoice
may contain one item or one hundred — it doesn’t matter. No matter what the repeating data items are all
stored in a single field.
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This database works a bit differently than the previous database. Instead of typing in the detail items you
drag them from the Books database.

When you release the mouse the item is added to the invoice.
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If you want to change the Quantity ordered of any line, click anywhere on the detail line to access this pop-up
menu and select Change Quantity.

Panorama will ask you for the new quantity.

When you press the OK button the invoice will be updated.

As you can see, all of the totals are recalculated also. As mentioned before, the best feature of this database is
that you can add as many detail lines as you like. As the number of lines grows you can scroll the items and/
or expand the window.
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How the Detail Lines are Stored

Let’s take a look at the design sheet for this database (on the left) and compare it to the design sheet for the
invoice database created using line item fields (on the right). Our new database stores all of the repeating
data (invoice items) in a single field, Items. As you’ll see, there is no limit to how many items can be stored in
the invoice. The database on the right uses 60 fields to store the repeating data and has a limit of 15 items per
invoice.
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How does all of this data get stuffed into a single field? Let’s look at the data sheet to see.

Each line in this cell corresponds to a detail line in the invoice (this is a carriage return delimited array, see
“Picking a Separator Character” on page 1364). This particular invoice has two lines, so there are two lines in
the Items field. Since a data cell can contain an unlimited number of lines each invoice can contain an unlim-
ited number of detail lines.

Within each line there are four “pseudo-cells”, each separated by the ~ character. The first pseudo-cell is the
quantity. The second pseudo-cell identifies what is being sold, in this case the ISBN number for the book. Of
course if you’re invoice isn’t for books you’ll need to use some other for of identification, perhaps a catalog
number or simply a description of the item. The third pseudo-cell is the price of the item, and the last is the
quantity times the price.

Displaying the Detail Lines

Obviously no one would want to edit the Items cell in the data sheet manually. Instead, this database uses a
Super Matrix Object to display the detail lines. The result looks like this.

qty isbn number price line total
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Let’s switch into Graphics Design Mode to see how this works. (You may want to review Super Matrix
Objects before continuing, see “Super Matrix Objects” on page 1057). This illustration shows Super Matrix
Object itself and the Frame Object (see “The Matrix Template (and Frame Object)” on page 1058). The frame
object contains the template for the data displayed in the matrix. When the database is actually in use the
window is shrunk so that the frame object and the template are invisible.

The actual data is displayed with four text display objects (see “Text Display SuperObjects™” on page 736).
The table below shows the four formulas used by these objects.

You’ll notice that all four of these contain this core in common. This section of the formula calculates the line
number being displayed. In this case ItemScroll is a global variable that is linked to the scroll bar (more on
that later).

(ItemScroll-1)+info("matrixrow")

Actually, all four of these actually contain a larger core in common. This larger core takes the line number and
uses it to extract the appropriate line of data from the Items array.

array(Items,(ItemScroll-1)+info("matrixrow"),ƒ)

Column Formula

Qty array(array(Items,(ItemScroll-1)+info("matrixrow"),ƒ),1,"~")

Item
lookup("Books",ISBN,

array(array(Items,(ItemScroll-1)+info("matrixrow"),ƒ),2,"~")
,Title,"",0)

Price array(array(Items,(ItemScroll-1)+info("matrixrow"),ƒ),3,"~")

Total array(array(Items,(ItemScroll-1)+info("matrixrow"),ƒ),4,"~")

super matrix object

frame object

text display objects
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If you look closely, you’ll see that there is even a larger commonality between each of these four formulas. A
second array( function (displayed in orange below) extracts the actual cell from within the line of data. The
four formulas aren’t exactly the same because they extract different cells — 1, 2, 3, and 4.

array(array(Items,(ItemScroll-1)+info("matrixrow"),ƒ),1,"~")

For the Quantity, Price and Total cells that’s it - this is the complete formula. But for the Item we don’t actu-
ally have the description, but just the ISBN number. To get the description we must use this ISBN number
and look up from the Books database using the lookup( function (see “Linking With Another Database” on
page 1400).

lookup("Books",ISBN,array(array(Items,(ItemScroll-1)+info("matrixrow"),ƒ),2,"~"),
   Title,"",0)

The end result is that the formulas are displayed over and over again by the Super Matrix Object, with the
formula adjusting to display the information for each line.

Scrolling the Detail Lines

An invoice may have more lines of data than will fit on the form. To handle this the database has a Scroll Bar
SuperObject (see “Scroll Bars” on page 1096). In this case the scroll bar is linked to a numeric field named
ItemScroll and to a procedure named .ItemScroll. The scroll bar could be linked to a variable, but by linking it
to a field Panorama will remember how each invoice is scrolled.
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The procedure is very short and relies on the Matrix SuperObject to do most of the work (see “Super Matrix
SuperObject™ Commands” on page 1962).

Adjusting for Window Size Variations

In addition to the normal elastic form adjustments the scroll bar must be adjusted for the number of visible
invoice lines. To do this the .AutoGrow Proc option is turned on when creating the elastic form.

With this option enabled Panorama will automatically trigger this procedure every time the window dimen-
sions are changed.

The second and third lines determine the number of lines that are currently being displayed (see “Super
Matrix SuperObject™ Commands” on page 1962). The final line sets the scroll bar page height to this number
(see “Scroll Bar SuperObject™ Commands” on page 1964). This adjusts the scroll bar so that clicking in the
page up/down area will cause the invoice items to move up or down one page.

page up

page down
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Mexican Restaurant

This database demonstrates another way to create an invoice. The menu items are listed on the left, with the
current order on the right.

Use the Add New Record tool to start a new order.

To add an item to the order, click on the item in the menu.
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The item will appear in the box on the right.

As items are added to the order the total is updated automatically.

An unusual feature of this database is that you can type in items “off the menu.” Simply click in the box on
the right and type in the item. The cost of the item must be preceded with a dollar sign ($) as shown below.

When you press the Enter key the database will calculate the new total, including the hand-entered “off the
menu” item.
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Sales Calendar

An unusual feature of this database is the Sales Calendar, which can be opened from the Action menu.

The Sales Calendar shows a summary of sales on each day. You can easily flip back and forth to compare rev-
enues with prior months or years.

To learn more about creating a calendar see “Building a Calendar” on page 1088.

Editing the Menu

To change a price or item description choose Edit Menu from the Action menu.
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This opens a second database that contains all the items on the database.

Once you have edited one or more items click back on the original database and choose Update Menu from
the Action menu. In this case we have increased the price of Hevos A La Mexicana by $1.00.
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More drastic changes will require editing the menu form. You’ll notice that the menu is divided into several
different categories. Each category is has a Super Matrix object to display the category (see “Super Matrix
Objects” on page 1057). The easiest way to create a new category is to make a copy of one of the existing cate-
gories, as shown here (see “Duplicating Objects” on page 688).

The menu category displayed by this object is controlled by the objects name. To change the category choose
the Object Name command from the Edit menu (see “Object Type/Object Name” on page 661).

The current name of this category is Extras.
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Type in the new category name, for example Drinks, then press OK.

To make this category appear you must switch to Data Access Mode and then add one or more items in this
category to the menu database (see above).

Now switch back to the Food Orders database and use the Update Menu command in the Action menu to
make the new Drinks category appear.

The final step, re-arranging the graphics to make room for the new category, is left up to you!
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ProVUE Order Entry

This is not a single database but actually six databases that work together as a complete order entry system.
This is actually a modified version of the order entry system we use here at ProVUE, so the design assump-
tions in this system are focused on a software or manufacturing company. However, the design can easily be
adapted for many different types of businesses.

The six database files are shown here.

The Invoice file is the primary file for this system. It contains all of the information for each order.
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The Customers database contains information and preferences for regular customers. This database is
designed for customers that order regularly (for example dealers or distributors), not one-time or occasional
customers. The system can use the information in this database to automatically give the correct discount to
each order placed by a regular customer.
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Product descriptions and pricing information are actually split up into three separate databases. The Prod-
ucts database contains the description of each product (the pricing information shown in the windows below
is actually being looked up from the Price List database). Each product must be assigned a product number
that is used to link this database with the Prices database (described below).

This system assumes that each product has a standard list price but also has other prices that are paid by dif-
ferent types of customers — dealers, distributors, educational institutions, etc. The system uses a three letter
code for each price category. These codes are kept in the Price Codes database, along with the standard dis-
counts for each of these categories (as you’ll see later, you can customize these discounts for each individual
product, or even for an individual invoice).
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The Prices database contains the actual prices for each product in each category. You usually won’t have to
use this database directly because the system has special forms for editing this data.

Your product database may contain hundreds or even thousands of products. The Product Collections data-
base helps organize these products into logical groups. You’ll usually use this to keep the most frequently
ordered products at your fingertips. You can even set up the profile for each regular customer so that when a
regular customer places an order the items they order most frequently automatically appear.
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Placing an Order from a Regular Customer

When a regular customer places an order, locate that customer in the Customers database and drag their
entry over the Invoice form. In this case we’ve received an order from a dealer named Golden Web.
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When you release the mouse the system will automatically create a new invoice. Using the information in the
Customers database the system fills in the contact information, discount code, and in this case, the reseller ID
(for sales tax exemption) as well). The system also brings forward the Product Collections window and
selects the collection that is appropriate for this customer (as specify in the Customers database).

reseller ID

discount code
(SDP = Standard Dealer Price)
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To add a product from this collection to this invoice, simply drag the product onto the invoice form. It doesn’t
matter exactly where you drag the product to on the form, anywhere will do. No matter where you release
the mouse the new product will be added on the next available line.

When the mouse is released the item is added to the invoice (the standard retail price of this book is $32.95,
but the system has automatically filled in the correct dealer price of $23.06).
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If you want to add a product from another collection, select the collection from the pop-up menu at the top of
the Product Collections window.

Once the new collection is selected you can drag items from it onto the invoice.
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You can also drag items directly from the Product List onto the invoice.

If you want to change the quantity, click on the number. This makes a dialog appear.

Enter the new quantity and press the OK button to update the invoice.
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To change the price of an item click on the number. This opens a dialog that allows you to adjust the price.

You can either select from a list of standard prices for this item or type in the exact price you want to use, in
this case $20.00. Press OK or the Enter key to update the invoice.

To complete remove an item from the order drag the item into the trash can.
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Placing an Order from an Occasional Customer

When a regular customer places an order use the Add New Record tool to create a new invoice.

This creates a new, blank order.

The system assumes that this occasional customer will receive PDP pricing (Public Direct Price). If this is not
the case you should edit this field now.

Discount code
(PDP = Public Direct Price)
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The next step is to fill in the contact and payment information for this order. Click in the box and then type in
the information.

Press the Enter key to add this information to the database.

The system has actually analyzed this information and split it into separate fields (see “Natural Data Entry”
on page 1783). To see the actual separate database fields press the Detail button. This opens the window
shown here, which allows you to see and edit the individual database fields.

Close the detail window when you are through with it.
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To add new items to the order drag them from the Product Collections or Products database just as you did
for the previous order.
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Since this order is outside of California, no sales tax is charged. If the address is changed to a California
address sales tax will be added.

The state for which sales tax is charged is defined in the TaxAndTotal procedure. If your company is in a dif-
ferent state you’ll need to modify this procedure.
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The sales tax rate itself is defined in the .Initialize procedure.

In the product database you can define an item as non-taxable.

When a non-taxable item is added to the invoice that item is not included in the tax calculation.

tax should not be charged on this item
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To change the shipping method click on the tiny shipping box. You can select the shipping option from the
list on the left. The system will calculate the price for you or you can manually type it in. If the customer
wants to pay for the shipping directly you can enter the account number on the right.

In some cases you may want to supply an order for no charge. To do this simply click the Free button.
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Adding Products to a Product Collection

The Product Collections database contains lists of frequently ordered items. To add an item to a collection
simply drag it from the Product database into the collection. (The illustration shows the item being dragged
into an empty spot, but that is not necessary, you can drag anywhere in the form.)

The item is added to the end of the collection.
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If you open the detail window for a product (by double clicking on the product list) you can add the product
to the collection with a specific price. Simply drag the price category onto the collection, in this case the edu-
cational price.

The educational price of the product is added to the collection.

If this product is dragged onto any invoice the item will appear at the educational price, no matter who the
customer is. In this case the customer’s normal discount level is ignored.
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To remove an item from a collection simply drag it into the trash can at the top of the window.

Use the pop-up menu to add a completely new collection.

The new collection is initially untitled, but you can type in any name you want.
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To complete the new collection drag items from the Products database on to it.

Adding a New Product

To add a new product, start by using the Add New Record tool.
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A new, empty product is added to the bottom of the list.

Double click this empty product to open the detail window.

Enter the name, product family, subfamily, icon and shipping weight (pounds). The product number is
assigned automatically (in this case 235). If the product is non-taxable click the Non-Taxable button.



Page 118 Panorama Handbook
Type in the standard retail price for the new product.

When you press the Enter key, the system asks if you would like it to calculate all of the other prices for you.

Press the Yes button. After a slight delay the other prices will appear. You can use these calculated prices as is
or edit them for your needs.

The system as automatically added the prices to the Prices database for you. You don’t ever need to edit this
database directly.



Page 119
The new product is ready to be used. Simply drag it onto the order form like any other product.

Of course you can also add the new product to the Product Collections database.

Learning More About the ProVUE Order Entry System

To learn more about this order entry system you can purchase our ProVUE 98 and ProVUE 99 CD-sets.

The ProVUE 98 set contains a session showing how this system was built. The ProVUE 99 set shows how to
add an on-line shopping cart to this order entry system, allowing users to enter their orders automatically
over the web. See See “Panorama Conferences” on page 2118 for more information on these CD-sets.
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